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1. Introduction 

This document describes the CHOReVOLUTION platform as an enabler of choreography-
based service composition, its principles of operation, the architectural modules and the 
overall usage. 

This document is intended to be used by choreography designers and deployers, as well as, 
system administrators. 

The document is organized into the following sections: 

 Choreographies and CHOReVOLUTION platform building blocks: the concept of 
choreographies, their advantages over classical orchestration, and the 
CHOReVOLUTION platform as an enabler of service choreographies; 

 Platform Installation and configuration guide: how to deploy, configure and run the 
various parts of the CHOReVOLUTION platform and how to ensure everything is 
ready to perform choreographies design and deployment; 

 Platform User and Administration guide: how to set up CHOReVOLUTION platform to 
design, deploy, run and control choreographies; 

 Platform components and API reference: describes the internals of every component 
of the CHOReVOLUTION platform and its exposed APIs. 

The CHOReVOLUTION platform is a highly integrated set of architectural components. All of 
the components must be set up and configured in order for a choreography to be correctly 
designed, deployed and executed. 

NOTE FOR THE READERS: this deliverable is an evolving document, in particular, the 
included platform manual will be updated based on the features added in the various 
platform releases. 

2. Choreographies and general structure of the 
CHOReVOLUTION platform 

Current approaches to internet based service composition are entirely based on the 
orchestration paradigm. In this paradigm, a centralized coordinator (the orchestrator service) 
contains all the business logic to execute the composition. This is the typical mode of 
operation of all the current web or Internet based services.  

In the choreography approach there is no centralized coordinator of the business logic, 
rather the coordination logic is distributed across each participant in the choreography. 
The need for service choreography was recognized in BPMN2 (Business Process Model and 
Notation Version 2.0), which introduced choreography-modeling constructs. Service 
choreographies model peer-to-peer communication by defining a multiparty protocol that, 
when put in place by the cooperating parties, allows reaching the overall choreography 
objectives in a fully distributed way. In this sense, service choreographies differ significantly 
from service orchestrations, in which one stake-holder centrally determines how to reach an 
objective through cooperation with other services.  
Service choreography is a decentralized approach that provides a loosely coupled way to 

design and realize service compositions by limiting the complexity of business logic 

description at design time and reducing it at runtime. 

In orchestrated compositions, all the services are passive entities from the internal point of 
view of the orchestrator service, i.e., services just provide operations that can be invoked by 
their consumers (request a service and get the response). However, future software systems 
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won’t be realized by orchestration only; they’ll also require choreographies. Indeed, services 
will be increasingly active entities that, by communicating peer-to-peer, proactively make 
decisions and autonomously perform tasks according to their own imminent needs and the 
emergent global collaboration. Thus, beyond consumers and producers, in choreographies 
there are also prosumers, which are both producers and consumers. 
Moreover, today software services are more and more performant, offer increasingly 

complex and advanced functionalities and, as such, more and more complex. Implementing 

all these functionalities from scratch is often inconvenient. Thus, to put choreography into 

practice, we must consider realizing service choreographies by also reusing third-party 

services, which often are not born to interact with each other as desired. This leads to 

consider the problem of choreography realizability enforcement. That is, given a 

choreography specification and a set of services, we must coordinate and possibly adapt 

their interaction - from outside - so as to fulfill the global collaboration prescribed by the 

choreography specification. 

However, when heterogeneous third-party services are to be composed, obtaining the 
distributed coordination and adaptation logic required to suitably realize a choreography is a 
non-trivial and error prone task. Automatic support is then needed, and here the 
CHOReVOLUTION platform comes into play providing support to the development of 
choreographies through automatic realizability enforcement. 
 

2.1. CHOReVOLUTION platform building blocks 

Figure 1 shows the CHOReVOLUTION platform as a toolbox of well-integrated 

frontend/backend components. The bottom of the figure depicts an example of a running 

CHOReVOLUTION choreography as a distributed  composition of services plus additional 

software entities (Coordination Delegates - CDs, Adapters - As, and Security Filters – SFs, 

and Binging Components - BCs) that the platform generated for choreography realizability 

enforcement purposes. 
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Figure 1. General structure of the CHOReVOLUTION platform 
As far as the CHOReVOLUTION platform building blocks are concerned, the following table 
describes the platform components that are shown in the top (frontend components) and in 
the middle (backend components) of Figure 1. 
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CHOReVOL
UTION 
building 
block 

Inputs/outputs Functions 

CHOReVOL
UTION 
Studio 

via GUI 
Choreography Modeler, Service Modeler, and 
Synthesis Processor Wizard. 
 
The Choreography Modeler allows the 
choreography designer to specify the choreography 
in term of BPMN2 Choreography Diagrams (by 
exploiting the Eclipse BPMN2 Modeler1), as well as 
additional models (by using CHOReVOLUTION ad-
hoc Eclipse plugins) to enrich the BPMN2 
specification. For instance, additional models allow 
to express choreography variability points so to 
support dynamic choreography evolution, or to 
specify identity roles and security-centric filtering 
policies so to support the realization of secure 
choreographies. For a complete description of 
them, we refer to deliverable D2.1 [D2.1]. 
 
For each service/thing registered in the Service 

Inventory by its provider, the Service Modeler 

allows to specify different aspects of its interaction 

behaviour, spanning from the service signature and 

protocol to its QoS and identity attributes [D2.1]. 

For instance, the interface and the interaction 

protocol models are used by the Synthesis 

Processor to correctly bind concrete services to the 

choreography roles that they have to play.   

 
The Synthesis Processor Wizard drives and assists 
the developer in automatically generating the 
needed BCs, SFs, As, and CDs through the 
Synthesis Processor. 

CHOReVOL
UTION 
Console 

via GUI 
Identity and Enactment Manager Console, and 
Choreography Execution Monitor. 
The Identity and Enactment Manager Console is a 
Web application which provides complete access 
for configuring, administering and triggering all the 
features provided by IdM and Service Inventory, 
including service provider and consumer identities 
life-cycle management and concrete service and 
choreography remote management. Moreover, this 
console allows for: 

1. accessing features provided by the 

                                            
 
 
 
1
 https://www.eclipse.org/bpmn2-modeler/. 

https://www.eclipse.org/bpmn2-modeler/
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Enactment Engine such as starting, 
stopping, pausing an execution item;  

2. eventually visualizing messages and data 
generated by an execution item. 

 
The Choreography Execution Monitor is a Web 
application that allows to monitor the execution of a 
CHOReVOLUTION choreography with respect to 
some parameters of interests. For instance, the 
execution time of a specific service operation 
including/excluding the time elapsed for the 
exchange of coordination information, the number 
of exchanged coordination messages needed for 
the execution of a specific business level task, etc. 
 

Synthesis 
Processor 

Receives the BPMN2 

Choreography 

Diagram and the 

additional 

choreography models 

specified to enrich it, 

produces the Concrete 

Choreography 

description (CC XML) 

and generates the 

needed Coordination 

Delegates (CDs), 

Adapters (As), and 

Security Filters (SFs). 

Binging Components 

(BCs) are generated 

by the VSB platform 

component (see 

below).  

The Synthesis Processor is the component that 
builds the choreography description (concrete 
choreography specification) based on the 
choreography specification and on the models of 
the participant services, as produced by using the 
Choreography Modeler and the Service Modeler, 
respectively. The concrete choreography 
specification is used to deploy the choreography on 
the cloud.  

 

The Synthesis Processor also generates (as 
suitable software artifacts, e.g., WARs) all the 
needed additional software entities that are 
required to enforce choreography realizability: 
Coordination Delegates (CDs), Adapters (As), and 
Security Filters (SFs). Binging Components (BCs) 
are generated by invoking the VSB Generator 
(described below).  

 

In particular, out of the BPMN2 Choreography 
Diagram, the additional choreography models 
specified to enrich the BPMN2 specification, and 
the involved services' models, the Synthesis 
Processor automatically generates a set of 
intermediate models that serve for automatically 
synthesizing the above mentioned additional 
software entities.  

 

Enactment 
Engine 

Receives the CC XML, 
deploys the 
choreography 
accordingly, listens to 
choreography 
adaptation and 
elasticity requests, 

The Enactment Engine (EE) automatically deploys 
the choreography based on the concrete 
choreography description document received from 
the Synthesis Processor. 

While the choreography could in theory be 
deployed manually, the EE is needed as 
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operates changes choreographies typically include several (potentially 
even thousands) of services and the manual 
deployment becomes impractical. 

The EE also interfaces with the IdM to pass it the 
updated CC document including the runtime details 
once a choreography is deployed and listens for 
command requests from the IdM for runtime 
choreography control.  

Federation 
Server 

The Federation Server 
receives information 
regarding users 
(credentials, 
permission, etc.) 
coming from the 
Identity Manager and 
provides credential 
mappings and 
authorization decisions 
used by the Security 
filter following the 
execution context.      

The Federation Server deals with ensuring 
interoperability among heterogeneous security 
mechanisms applying to different choreography 
peers. 

VSB 
Manager 
(eVolution 
Service Bus - 
VSB) 

Receives the 
service/thing GMDL 
representation and the 
choreography protocol 
and produces a 
Binding Component 
(BC). 

The eVolution Service Bus (VSB) is responsible for 
the incorporation of heterogeneous services/Things 
to the choreography. This is done through the 
generation of a BC for each service/Thing. More 
specifically, the VSB Manager receives the GMDL 
representation of a service/Thing and the 
choreography protocol through its REST API and 
generates a Binding Component (BC). Each 
generated BC is lightweight, as it implements only 
the supported interactions of the corresponding 
service/Thing.  

Identity 
Manager 

Receives concrete 
choreography 
specifications, end-
users and mobile-app 
data; produces end-
users and mobile-app 
data for Federation 
Server, controls and 
enforce security 
contexts on Security 
Filter instances 

The Identity Manager (IdM) is responsible for 
managing users and services. In particular, the 
Identity Manager is able to: query the services for 
supported application contexts and played roles, 
force a specific application context for a certain 
service (put in “maintenance” or disable/enable), 
query services about their global status 
(monitoring).  

 

Service 
Inventory 

Receives service / 
thing description, 
produces service 
information for the 
Synthesis Processor 

The Service Inventory is a logical feature provided 
by the Identity Manager. It acts as a central 
repository for information about services / things 
that can be involved in one or more 
choreographies. 
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As already anticipated, the software entities that come into play in a running 
CHOReVOLUTION choreography are services/things, Binding Components (BCs), Security 
Filters (SFs), Adapters (As), and Coordination Delegates (CDs). 

A Service can be of two types: 

 Legacy services - already existing producer services (e.g., Google Maps, a specific 
service from a Public Administration providing traffic information of some sort, a 
meteo service); 

 Deployable services - either consumer or prosumer  services that can be dynamically 
deployed during choreography deployment. As a CHOReVOLUTION-enabled service, 
a consumer/prosumer service declares required interfaces that must be late-bound to 
concrete service providers that offer them. For this reason, a consumer/prosumer 
service is required to expose a specific operation (called setInvocationAddress) that 
allows the EE (or the deployer) to dynamically bind the service required interface to a 
concrete producer. Furthermore, CHOReVOLUTION-enabled services exposing 
dedicated interfaces can be configured, monitored, controlled, and managed at run 
time by choreography operators. 

A Thing, in the Internet of Things (IoT), can refer to a wide variety of devices such as built-in 
sensors, operation devices, monitors, or any other natural or man-made object that can be 
assigned an IP address. These devices collect useful data with the help of various existing 
protocols and then autonomously flow the data between other devices. In the 
CHOReVOLUTION project, we study existing protocols, which are developed through the 
most recent and lightweight middleware technologies (e.g., REST, CoAP, MQTT, and 
WebSocket). 

A Security Filter requires a configuration file to enforce security-centric filtering policies on 
the global choreography participant services' interaction. The inputs come from the Identity 
Manager (during runtime) and the Enactment Engine (during choreography deployment and 
reconfiguration). A Security Filter undertakes the application of security interoperability 
mechanisms by acting as a proxy of a service/thing (provider side) in its interaction with a 
different service/thing (consumer side). 
A Binding Component (BC) is associated to a service/thing to convert its middleware 
protocol to the choreography common bus protocol, when these two protocols are different. 
The BC is generated after introducing to the VSB manager the service/thing representation 
(data types, middleware protocol, etc) and the common bus protocol. For 
CHOReVOLUTION, in most cases the common bus protocol is SOAP. However, the VSB 
solution is general enough to support any adequate protocol.  
Coordination Delegates coordinate the service interaction, in a fully distributed way, 
according to the collaboration prescribed by the BPMN2 choreography specification. 
Furthermore, exploiting the information specified in the additional models enhancing the 
BPMN2 specification, Coordination Delegates are also able to support choreography 
dynamic evolution.  
Adapters bind concrete services to the abstract participants defined by the choreography 
specification, hence enabling reuse of existing services. 
 

2.2. Choreography realization phases 

This section describes the general process of designing, deploying, running and monitoring a 
CHOReVOLUTION choreography. Technically speaking, once deployed, a choreography is 
physically a set of resources running on top of a cloud computing platform or in any location 
in the Internet.  

Realizing a choreography requires the following steps: 
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 Designing the choreography: using the Choreography Modeler, the operator 
specifies the collaborative logic of the choreography participants following a standard 
BPMN2-based approach, yet enhanced to deal with the pecularities of 
CHOReVOLTUION choreographies (e.g., variability points and security-centric 
policies mentioned above).  

 Synthesizing the choreography: once ready, the operator decides to prepare the 
choreography for deployment. Based on the enhanced BPMN2 model of the 
choreography and on the models of the participant services as selected into the 
Serivce Inventory, the Synthesis Processor computes the concrete choreography 
description file, which contains all the technical details after the choreography 
specification produced through the Choreography Modeler has been transformed into 
a real choreography of services. The Synthesis Processor Wizard will guide the 
operator through the required steps. Furthermore, the Synthesis Processor also 
produces all the needed Security Filter, Adapters, and Coordination Delegates. 
Binding Components are also generated through the interaction with the VSB 
Manager. 

 Deploying the choreography: when the concrete choreography description file is 
ready, the operator finally decides to deploy the choreography in the field. This action 
passes the concrete choreography description file to the Enactment Engine, which 
takes care of all the interfacing with the cloud providers (specified at design time) to 
summon the virtual machines or containers, deploy the service (and additional 
software) artifacts, configure them according to the concrete choreography description 
file, set the IP addresses, etc. 

 Running and monitoring the choreography: once the choreography is deployed, 
the Enactment Engine passes the updated concrete choreography description file to 
the Identity Manager that allows the operator to perform management operations by 
means of the Identity and Enactment Manager Console. In particular, the console 
shows the details of the deployed choreography and allows the operator to request 
actions on it such as pausing, starting, stopping or advanced actions such as scaling 
the resources or replacing services. Every action is passed by the Identity Manager to 
the Enactment Engine via a specific interface which then translates into an automatic 
provisioning task performed (if possible) on the deployed services. 

 Shutting down and releasing: this step is not mandatory, because obviously a 
deployed choreography might run forever. However, if a choreography is no longer 
needed, via the Identity and Enactment Manager Console the operator might decide 
to shut it down and release its resources. By issuing this command, the Identity 
Manager asks the Enactment Engine to remove the choreography. This results in a 
set of actions performed on the cloud providers that will ask for a complete removal of 
the deployed VMs or containers. This action is irreversible. After a shutdown and 
release, the only way of bringing a choreography back in action is to deploy it again 
from scratch. 

 

2.3. CHOReVOLUTION Platform Release Notes 

The following table specifies what are the features supported by the first release (M12, 
december 2015) of the platform. As one can see, 28 of 46 planned features are already 
supported by the first prototype release. Furthermore, 9 more features are partially 
supported.  
  

CHOReVOLUTION 
building block 

Component Feature Roadmap 
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CHOReVOLUTION 
STUDIO 

   

 Choreography 
Modeler 

BPMN2 
Choreography 
Modeling           

Supported at 
M12 

  QoS Specification Planned for 
M24 

  Variability Modeling Planned for 
M24 

  Identity Modeling Planned for 
M24 

 Service Modeler Interface Modeling  Supported at 
M12 

  Interaction Protocol 
Modeling 

Supported at 
M12 

  QoS Specification Planned for 
M24 

  Identity Modeling Planned for 
M24 

  Security 
Specification 

Planned for 
M24 

 Synthesis Processor 
Wizard 

CTLS Generation Supported at 
M12 

  CLTS Editor Supported at 
M12 

  Coord Model 
Generation 

Supported at 
M12 

  Coord Model Editor Supported at 
M12 

  Coordination 
Delegate Generation 

Supported at 
M12 

  Adapter Model 
Generation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

  Adapter Model 
Editor 

Partially 
supported at 
M12, Fully 
supported 
from M24 

  Adapter Generation Partially 
supported at 
M12, Fully 
supported 
from M24 

  “Concrete 
Choreography 
Specification” 
Generation 

Supported at 
M12 

CHOReVOLUTION 
Console 
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 Identity and 
Enactment Manager 
Console 

Service and Service 
Identity Role 
definition 

Supported at 
M12 

  Concrete 
choreography 
management 

Planned for 
M24 

  Concrete service 
management 

Planned for 
M24 

  End-user 
management 

Supported at 
M12 

 Choreography 
Execution Monitor 

 Partially 
supported at 
M12, Fully 
supported 
from M24 

Synthesis Processor    

 M2M Transformator BPMN2 
Choreography 
Specification to 
CLTS model 

Supported at 
M12 

  CLTS Model to 
Coord Models 

Supported at 
M12 

 Behaviour Simulator Simulation of 
concrete services 
against 
choreography 
participants 
projections 

Supported at 
M12 

 Adapters Generator Adapter(s) 
generation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

 CDs Generator Coordination 
Delegate(s) 
generation 

Supported at 
M12 

 Security Filters 
Generator 

Security Filter(s) 
generation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

Enactment Engine    

 Rest API Receiving a 
choreography's 
specification 

Supported at 
M12 

  Returning 
information related 
to a deployed 
choreography 

Supported at 
M12 

  Receiving 
commands (actions) 
to be performed on a 

Planned for 
M24 
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deployed 
choreography 

 Choreography 
Deployer 

Instantiate the 
needed VMs on the 
underlying cloud 
infrastructure, 
configuring them 
with the neede 
software artifacts 

Supported at 
M12 

  Generate the 
concrete ChorSpec 
XML file, with 
information about 
the actual VMs 
instantiated 

Partially 
supported at 
M12, Fully 
supported 
from M24 

 Monitor Monitor the state of 
the VMs instantiated 

Planned for 
M24 

 Dynamic 
choreography 
modifier 

Scale up/down a VM Planned for 
M24 

  Scale across a VM Planned for 
M24 

  Replace at runtime a 
choreography's 
service with its 
substitute defined in 
the ChorSpec 

Planned for 
M24 

Federation Server    

 Security Token 
Service (STS) 

Interface 
specification 

Supported at 
M12 

  Interface 
Implementation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

  Credentials 
validation 

Planned for 
M24 

  Credentials mapping Planned for 
M24 

  Users management Planned for 
M24 

 Policy Decision Point 
(PDP) 

Interface 
specification 

Supported at 
M12 

  Interface 
Implementation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

  Policy generation to 
XACML3.0 format 

Planned for 
M24 

  Access Policy 
management 

Supported at 
M12 
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  Receiving 
enforcment demand 

Supported at 
M12 

  Policy computation Supported at 
M12 

 Security filter Interface 
specification 

Supported at 
M12 

  Interface 
Implementation 

Partially 
supported at 
M12, Fully 
supported 
from M24 

  Request 
authentication to the 
STS 

Planned for 
M24 

  Requesty 
authorization to the 
PDP 

Planned for 
M24 

Identity Manager    

 Service Inventory Service and Service 
Identity Role 
definition 

Supported at 
M12 

  Service data update 
with concrete 
coordinates, upon 
successful 
choreography 
deployment 

Planned for 
M24 

 Identity Manager Runtime information 
from Security Filter 
instances 

Supported at 
M12 

  Enable / disable 
services via Security 
Filter instances 

Supported at 
M12 

  Force security 
contextes through 
Security Filter 
instances 

Supported at 
M12 

  Provision end-users 
to Federation Server 

Supported at 
M12 

The following chapters will focus on the description of the platform components as released 
to offer the supported features. Chapters 3 and 4 are starting points for the construction of 
an online user and installation guide that will be developed during year two of the project and 
maintained during the remaining years of the project. 

3. Platform User and Administration Guide 

3.1. Modelling a Choreography  

This section provides a quick start tutorial on how to create a Chorevolution project 

within the CHOReVOLUTION Studio and how to model a sample choreography. 

Currently, the CHOReVOLUTION Studio provides the following features: 
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 create or import choreography diagrams 

 generate clts models from a choreography diagram (next sections); 

 generate coord models from a clts model (next sections); 

 generate coordination artifact from a coord model files as *.war files (next 

sections). 

 

3.1.1. Setting up the CHOReVOLUTION Workbench preferences 

The user can manage the CHOReVOLUTION source model folders in Preferences Dialog: 

1. Start CHOReVOLUTION Studio. 

2. Select ECLIPSE > Preferences > Chorevolution, as shown in the Figure 2. 

 

 

Figure 2 – Preferences panel 

 

3.1.2. Setting up a CHOReVOLUTION Project 

To create a CHOReVOLUTION project: 

 
1. Start CHOReVOLUTION Studio. 

2. In the IDE, choose File > New > Project, as shown in the figure.  

 



 

CHOReVOLUTION  14 
Grant agreement no: 644178  

 

Figure 3. File menu 
 

3. In the Select a wizard page, select Chorevolution category. 

 

 

Figure 4. “Select a wizard” panel 
 

4. Select Chorevolution Project. Then click Next.  

 

5. In the Project name field, type the name of the project, e.g., 

TrafficEstimationProject. Leave the Use default location checkbox 

selected (as shown in the figure below). 
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Figure 5. New Chorevolution Project panel (1/2) 
 
 
6. Then click Next. You should see the default names of the newly created folders project.  
 

 

Figure 6. New Chorevolution Project panel (2/2) 
 
 
7. Click Finish. You should see the following window. 
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Figure 7. Chorevolution Project Setting panel 
 

8. The Chorevolution project is associated the Chorevolution Perspective. Click Yes. 

You will see the following figure. 
 

 

Figure 8. Chorevolution Perspective window 
 
The project is created and opened in the IDE. In the Project Explorer view you can quickly 
navigate between elements within the selected folder or file created. 
 

3.1.3. Adding Choreography diagram 

As a first step, you need to add the choreography diagram by using the Eclipse BPMN 

modeler. You can add or import diagram in Choreography Diagrams folder.  
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To create a Choreography diagram: 

1. Click on Choreography Diagrams folder > New > Other 

 

2. Select Chorevolution > BPMN 2.0 Choreography Diagram as shown in figure 

 

 

 

3. Click Next. In File name field, type the file name of the BPMN2 file, e.g., 
searp.bpmn: 

 You can specify the Location and Target Namespace by using the related 

field;  

 Click Finish. 
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Figure 9. New BPMN2 Choreography Diagram panel 

 

4. In the IDE, the BPMN 2.0 view is opened and the choreography diagram can be 

created by using the elements shown in the related palette.  

 

 

Figure 10. BPMN 2.0 view window 
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3.2. Modelling a Service  
Before the choreography modeling steps (Section 3.1), this step is usually perfomed by 
service providers that are interested in registering their own services in the 
CHOReVOLUTION Service Inventory. In the current release of the CHOReVOLUTION 
Studio, beyond providing their interface description, e.g., by means of the WSDL notation, 
services in the inventory must be equipped with the description of their ipLTS model (whose 
metamodel is defined in deliverable D2.1 [D2.1]). This model allows to specify the interaction 
protocol of the service in terms of the sequences of input/output messages that the service 
expects to exchange with its clients for a correct usage of it. Similarly to what already 
described in previous section for what concerns the modeling of a choreography, the 
CHOReVOLUTION Studio offers a dedicated editor to model the service interaction protocol 
description. This first release provides an XML tree-based editor. In the next release, we will 
provide a more user-friendly editor that will permit the creation of the ipLTS model through a 
graphical user interface. For instance, the service interaction protocol will be created by 
using an automata based graphical representation. In order to use this editor, the 

CHOReVOLUTION Studio offers a dedicated wizard to create a Chorevolution Service 

project. At the end, the model produced within this project are automatically uploaded into 

the Service Inventory provided that the URL of the inventory has been specified. Next 
releases will also provide editors for creating the other additional service description models 
discussed in deliverable D2.1 [D2.1], e.g., QoS description, Indentity and Security 
descriptions. 

 

3.3. Synthesizing a Choreography  

The section explains how to generate the Choreography LTS (CLTS) out of the 

specified BPMN2 Choreography Diagram. Then, the Coordination Models 

(CoordModel) can be generated from the CLTS. In turn, the Coordination Delegates 

artifacts can be generated out of the Coordination Models. 

 

3.3.1. Creating the CLTS Model out of the BPMN2 Choreography Diagram 
To create the CLTS Model from the BPMN2 Choreography Diagram: 

1. Select your BPMN2 diagram in the Choreography Diagrams folder. 

2. Right-Click on Chorevolution Tools > Generate Choreography LTS Model. 
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Figure 11. “Generate Choreography LTS Model” menù item 

 

3. The  command creates two new files in the Syntesis Processor > clts > model 

folder: searp.aird and searp.clts file. The former is the graphical representation 

of the CLTS. 

   

 

Figure 12. CLTS model window 
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3.3.2. Creating Coordination Models out of CLTS Models 

In order to generate the required coordination models from the CLTS model: 

1. Select searp.clts file in the Syntesis Processor > clts > model folder. 

2. Right-Click on Chorevolution Tools > Generate Coordination Models. 

 

 

Figure 13. Generate Coordination Models menù item 

 

3. The  command adds a set of .coord files in the Syntesis Processor > coord > 

model folder as shown in figures below. You can open .coord file in two different 

view: textual mode (xml view) and graphical mode. 
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Figure 14. Xml view window 

 

 

Figure 15. Graphic mode window 

 

.  

 

3.3.3. Creating Coordination Delegates from Coordination Models 

In order to generate a coordination delegate artifacts from a coordination model: 
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1. Select each .coord file in the Syntesis Processor > coord > model folder. 

2. Right-Click on Chorevolution Tools > Generate Coordination Delegate. 

A multiple selection (or the folder selection) allows for generating all the models one 
step. 

 

Figure 16. “Generate coordination delegate” menù item 

3. For each coordination model a .war file is generated and placed into the 

Syntesis Processor > coord > artifact  folder as shown in the following 

figure.  

 

Figure 17. Artifact and model folders structure 

 

3.4. Deploying a Choreography 

After the choreography synthesis steps have been accomplished as previously described, 
the Synthesis Processor builds the Concrete Choreography Specification (in ChorSpec 
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format) document, called the CC, an XML document containing all the details that describe 
the various nodes of the choreography and their dependency. 

Issuing the “deploy” action from the Modeler GUI makes the Synthesis Processor pass the 
CC to the EE for physical choreography deployment. 

The deployment process is automatic, requiring no further action to the operator, as long as 
all of the parameters to connect to the cloud provider (user credentials) were correctly 
specified in the EE configuration file. The following paragraphs descibes the processes 
happening behind the scenes. 

To ease the reading, we will refer here to a deployment done on OpenStack. The following 
shows an example of the EE configuration file (see section 4.7 for further details) for an 
OpenStack based cloud provider: 

 
MYOPENSTACKACCOUNT.CLOUD PROVIDER=OPENSTACK 

MYOPENSTACKACCOUNT.OPENSTACK KEY PAIR=oSuser 

MYOPENSTACKACCOUNT.OPENSTACK PRIVATE SSH 

KEY=/home/user/.ssh/nopass 

MYOPENSTACKACCOUNT.OPENSTACKTENANT=Choreography 

MYOPENSTACKACCOUNT.OPENSTACK USER=oSuser 

MYOPENSTACKACCOUNT.OPENSTACKPASSWORD=SECRET 

MYOPENSTACKACCOUNT.OPENSTACK IP=http://172.16.123.123:5000 

MYOPENSTACKACCOUNT.OPENSTACK IMAGE 

ID=RegionOne/1654b5b649b74039b7b70e42e85480f4 

The EE will at this point interface with the OpenStack API and start asking for a number of 
virtual machines as per CC document requirements. After the VM creation is completed (and 
each VM received its IP address), the EE will install the required services taken from the 
Service Inventory. 

At complete deployment, put the choreography in “stopped” state, passing the annotated CC 
to the IdM for GUI rendering. 

In case of failures during the deployment process the user is notified with a meaningful error 
message. At this point the user should either review the choreography in the synthesis 
processor or contact the system administrator. Once solved all the issues the user should 
retry the deployment. 

 

3.5. Running and monitoring a Choreography  

Each running choreography and each single service in the choreography has its own ID (a 
numeric code). From the Identity and Enactment Manager Console the operator can select 
the choreography or any of its services and request runtime control actions: 

 Actions at the choreography level: 

o Start: the choreography is instructed to start responding to service requests. 
The start command can be given to a deployed choreography in a stopped 
state. 

o Stop: the choreography stops processing user requests. This command can be 
issued on a running choreography. It does not shutdown the service, but only 
makes the services stop answering to user requests. This translates typically 
into putting virtual machines or container in a “pause” state, but eventually 
depends on how the choreography is physically deployed. 
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o Shutdown and release: the choreography is physically shut down and its 
resources are released from the cloud. This command can be issued on any 
deployed choreography. 

 At the service level: 

o Start/stop: this command makes the service stop or start processing 
messages. The impact of a stopped service on a running choreography 
depends on the role of the service in the chain based on the BPMN 
specification. Impact is not evaluated, it is up to the operator to understand. 
Stop or start can be issued only to deployable services. Legacy services are 
not affected. 

o Scale up/down: this command requests more resources to be provided for the 
single service instance (e.g., more RAM, more CPU). The command translates 
in a request to the cloud provider. The possibility to scale up or down depends 
on the cloud provider selected and on the physical capabilities of the cloud 
itself. If the command is not feasible, the resources will stay the same and the 
operator will not see any change. 

o Scale across: this command translates into a request to the cloud provider to 
clone the VM or container and load balance the traffic across the service 
instances. The operator can specify how many additional instances are 
needed. 

o Replace the service: this command automatically changes the pointer to the 
next service in chain towards another service identified as a replacement at 
design phase. The replacement has no options, the replacement service must 
be configured at design time, otherwise the operation will not be possible. 

The EE updates the runtime information in the IdM each time a change in the choreography 
is requested, with the following process: 

 The initial update happens at the end of the initial deployment: the EE passes the full 
CC document to the IdM with the runtime information 

 Once a control command is issued by the operator using the IdM console, the EE 
performs the required change and sends back the entire updated CC document to the 
IdM 

 

3.6. Shutting down and releasing  

The shutdown and release function in the IdM GUI allows the operator to ask for a complete 
deletion of a running choreography resources from the cloud providers infrastructures. There 
are no separate shutdown and release functions, this is a single action. To simply stop the 
choreography use the “stop” command. 

The shutdown command will require a further confirmation from the operator. After the 
command is confirmed, the EE will proceed by physically deleting every resource that was 
reserved on the cloud platforms. Shutdown only applies to components and nodes deployed 
by the EE, it does not affect in any way the legacy services. 

The shutdown operation is harmless in configuration terms as long as the deployment and 
management process described until now is followed. If the choreography is mistakenly 
deleted, it can be re-deployed using the same BPMN model or CC (from the Modeler 
interface). 

In deliverable D2.2 [D2.2] we described the CHOReVOLUTION methodology to deal with 

dynamic evolution. In particular, a key aspect concerns the ability to distinguish between 
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fixed portions of the choreography and variable ones, based on which modular changes can 

be dynamically applied by pausing only the affected choreography portion. However, in this 

first release of the CHOReVOLUTION platform, any kind of changes requires a 

choreography shutdown. 

 

4. Platform installation and configuration guide 

The following subsections will include more detailed instructions on how to install and 
configure the frontend and backend components constituting the CHOReVOLUTION 
platform (Figure 1). 

 

4.1. CHOReVOLUTION Studio  
The CHOReVOLUTION Studio is an Eclipse-based development environment that is 
customized for developing choreography service oriented systems. It provides a ready-to-
use environment to design, synthesize, deploy and enact a choreography by using the 
CHOReVOLUTION platform. 
It is freely available for development and internal business operations use with no time limits, 
fully open-source and licensed under the terms of the Apache License 2.0. 
 

4.1.1. Installation requirements 
To make the most out of the CHOReVOLUTION products, please consider the following 
hardware and software requirements. 
Memory usage heavily depends on the size and nature of your CHOReVOLUTION projects. 
However, in summary, if your Jobs include many transformation components, you should 
consider upgrading the total amount of memory allocated to your tool, based on the following 
recommendations. 
 

Table 1 - Memory usage 

Product Recommended alloc. memory 

CHOReVOLUTION Studio 1.5GB minimum, 2GB recommended 

The same requirements also apply for disk usage. It also depends on your projects but can 
be summarized as: 
 

Table 2 - Disk usage 

Product Required disk space for 
installation 

Required disk space for use 

CHOReVOLUTION Studio 1.5GB 1.5+ GB 

 

4.1.2. Compatible Platforms and Java environments 
Please refer to the following grids for a summary of supported OS and Java Runtime 
environments. 
 

Table 3 - Java environments 

Support type Vendor Version 

Recommended Oracle Java/JDK 8 

Supported with limitations Oracle Java/JDK 7 

https://www.apache.org/licenses/LICENSE-2.0.txt
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Table 4 - CHOReVOLUTION Studio 

Support type OS Processor 

Recommended 
 

Unix Linux 64-bit 

Windows Microsoft Windows 64-bit 

Mac OS OS X 64-bit 

Supported 

Unix Linux 32-bit/64-bit 

Windows Microsoft Windows 32-bit/64-bit 

Mac OS OS X 32-bit/64-bit 

 

4.1.3. Downloading and installing CHOReVOLUTION Studio 
In the Download section of the CHOReVOLUTION project Website 

(http://www.chorevolution.eu), a CHOReVOLUTION Studio package is available for 

installation on your application server of choice. After that, you can deploy the web archive 
depending on the mode of your application server (e.g. in Tomcat you can copy the .war in 

the webapps directory). Once the download is complete, extract the archive file on your hard 

drive and double click on ChorevolutionStudio executable file. 

Configure the memory settings 

 If you want to tune the memory allocation for your JVM, you only need to edit the 

ChorevolutionStudio.ini file corresponding to your executable file.  

Learn more on http://www.oracle.com/technetwork/java/hotspotfaq-138619.html. 

 

4.2. CHOReVOLUTION Console 
The CHOReVOLUTION Console, still under development at the time of writing, will be 
composed by the following subcomponents: 

- Identity and Enactment Manager Console,  
- Choreography Execution Monitor. 

The Identity and Enactment Manager Console is a Web application which provides complete 
access for configuring, administering and triggering all the features provided by IdM and 
Service Inventory, including service provider and consumer identities life-cycle management 
and concrete service and choreography remote management.  
Moreover, this console allows for: 

1. accessing features provided by the Enactment Engine such as starting, stopping, 
pausing an execution item;  

2. eventually visualizing messages and data generated by an execution item. 
The Choreography Execution Monitor is a Web application that allows to monitor the 
execution of a CHOReVOLUTION choreography with respect to some parameters of 
interests. For instance, the execution time of a specific service operation including/excluding 
the time elapsed for the exchange of coordination information, the number of exchanged 
coordination messages needed for the execution of a specific business level task, etc. 

 

4.3. Synthesis Processor  
The Synthesis Processor is provided as a set of REST-services and it is bundled as a Java 
web application that can be deployed into any Java EE application server (e.g., Apache 
Tomcat). 
It is freely available for development and internal business operations use with no time limits, 
fully open-source and licensed under the terms of the Apache License 2.0. 
  

http://www.chorevolution.eu/
http://www.oracle.com/technetwork/java/hotspotfaq-138619.html
https://www.apache.org/licenses/LICENSE-2.0.txt
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4.3.1. Installation requirements 
To make the most out of the CHOReVOLUTION products, please consider the following 
hardware and software requirements. 
Memory usage heavily depends on the size and nature of your CHOReVOLUTION projects. 
However, in summary, if your Jobs include many transformation components, you should 
consider upgrading the total amount of memory allocated to your tool, based on the following 
recommendations. 
 

 Table 5 - Memory usage 

Product Recommended alloc. memory 

Synthesis Processor 128MB minimum, 256MB recommended 

 
The same requirements also apply for disk usage. It also depends on your projects but it can 
be summarized as follow: 
  

Table 6 - Disk usage 

Product Required disk space for 
installation 

Required disk space for use 

Synthesis Processor 25MB 50MB 

 

4.3.2. Compatible Java environments and Java Web Container 
Please refer to the following grids for a summary of supported Java Runtime environments. 
  

Table 7 - Java environments 

Support type Vendor Version 

Recommended Oracle Java/JDK 8 

Supported with limitations Oracle Java/JDK 7 

 
It can be used any Java Web Container that it implements the Java Servlet 3.1 Specification. 
For example the latest version of Apache Tomcat (http://tomcat.apache.org). 
  

4.3.3. Downloading and installing 
In the Download section of the CHOReVOLUTION project Website 

(http://www.chorevolution.eu), a .war package is available for installation on your 

application server of choice. After that, you can deploy the web archive depending on the 

mode of your application server (e.g. in Tomcat you can copy the .war in the webapps 

directory). 

 

 

4.4. Federation Server 
The Federation Server is in charge of solving, as much as possible, the different security 
interoperability issues. For that, its design is based on the fact that the different services, 
involved in choreographies, will need authentication mechanisms. The Federation Server is 
composed of two elements, the Security Token Service (STS), the Policy Decision Point 
(PDP). The two components could be installed on the same Web server or separately. 
The deployment of the different elements must be realized on Ubuntu Linux distribution with 
a running Tomcat server. 

http://tomcat.apache.org/
http://www.chorevolution.eu/
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It is open-source and licensed under the terms of the Apache License 2.0.  
 

4.4.1. Installation requirements 
To make the most out of the CHOReVOLUTION products, please consider the following 
hardware and software requirements. 

Table 1 - Memory usage 

CHOReVOLUTION Client Recommended alloc. memory 

Federation Server 2GB minimum 

 
The same requirements also apply for disk usage. It also depends on your projects but can 
be summarized as: 

Table 2 - Disk usage 

Product Required disk space for 
installation 

Required disk space for 
use 

Federation Server 2GB min  2GB min  

 

4.4.2. Compatible Platforms and Java environments 
Please refer to the following grids for a summary of supported OS and Java Runtime 
environments. 

Table 3 - Java environments 

Support type Vendor Version 

Recommended Oracle Java/JDK 8 

Supported with limitations Oracle Java/JDK 7 

 

Table 4 - Federation Server 

Support type OS Version Processor 

Recommended Unix Linux Ubuntu 14.04 64-bit 

Supported Unix Debian-based distribution  64-bit 

 

4.4.3. Downloading and installing of  the Federation Server 

PDP installation 
The PDP installation is realized using the following commands 
Download the last version of the PDP Debian package using the following commands: 
sudo aptitude install gdebi curl 

sudo gdebi PDP_V1.0.deb 

At the end, you will see a message giving optional instructions to go through. Please follow 
them as necessary. 
At the end of the installation, a tomcat server is running with the PDP and with a minimal 
domain configuration 

STS installation 
The STS is provided as a war archive ready to deployed into a running tomcat (The PDP 
tomcat could be used, as well). For that, copy the STS war archive to the webapps directory 
of tomcat. No specific tomcat configuration are required (Except port configuration). 

 

4.5. eVolution Service Bus  
The eVolution Service Bus (VSB), is provided as a REST-service, named VSB Manager, and 
it is bundled as a Java application. The VSB manager generates Binding Components (BCs) 

https://www.apache.org/licenses/LICENSE-2.0.txt
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in order to interconnect two different middleware protocols. Subsequenlty, each BC is 
provided as a REST-service, named BC Manager, and is bundled as a Java application.  

4.5.1. Installation requirements 
The hardware and software requirements are summurized in the tables below: 

Table 8 - Memory usage 

Product Recommended alloc. memory 

VSB Manager 1 GB minimum 

BC Manager 500 MB minimum 

 

Table 9 - Disk usage 

Product Required disk space for 
installation 

Required disk space 
for use 

VSB Manager 2GB minimum 300 MB minimum 

BC Manager 2GB minimum 300 MB minimum 

 

Table 10 - Java environments 

Support type OS Version Processor 

Recommended All Oracle Java/JDK 8 All 

Supported with limitations All Oracle Java/JDK 7 All 

 

 

4.6. Identity Manager  
The CHOReVOLUTION Identity Manager (IdM) is a product suite based on Open Source 
projects Apache Syncope and ConnId, allowing the specification of identity-oriented service’s 
operational profiles and their dynamic interpretation and handling to cope with security 
issues. 
 
The CHOReVOLUTION IdM is responsible for: 

1. Service Inventory management; 
2. service provider and consumer identities life-cycle management; 
3. concrete service and choreography remote management. 

 
Interaction with CHOReVOLUTION IdM is available through 

 REST API - for invocation by Synthesis processor and Enactment Engine; 

 web administration console - for administering concrete services and choreographies; 

 web end-user console - for end-users self-registration, self-management and mobile 
apps enrollment. 

 
The CHOReVOLUTION IdM also exploits suitable connectors for identity management that 
enable the communication with external resource such as concrete services (through 
Security Filter instances) and Federation Server. The CHOReVOLUTION IdM is Open 
Source and released under the terms of Apache License 2.0. 
 

4.6.1. Installation Requirements 

The hardware requirements depend greatly on the given deployment, in particular the total 
number of managed entities (users, groups and any objects), their attributes and resources. 

http://syncope.apache.org/
http://connid.tirasa.net/
https://www.apache.org/licenses/LICENSE-2.0.txt
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 CPU: dual core, 2 GHz (minimum) 

 RAM: 2 GB (minimum) 

 Disk: 250 MB (minimum) 

 

The software requirements can be summarized as: 

 Latest Oracle JDK or OpenJDK 8 available is recommended, latest Oracle JDK 7 or 
OpenJDK 7 available is also supported 

 Latest Apache Tomcat 8 available 

 PostgreSQL 9.4 

 

Essentially any 64bit operating system capable of running the JDK and PostgreSQL (as 
enlisted above) is supported, with preference for Debian GNU / Linux and Ubuntu Server 
LTS. 
 

4.6.2. Installation Procedure 

From the Download section of the CHOReVOLUTION project website some packages are 
available: 

1. CHOReVOLUTION IdM Core 

2. CHOReVOLUTION IdM Console 

3. CHOReVOLUTION IdM Enduser 

4. CHOReVOLUTION IdM ConnId Security Filter Bundle 

5. CHOReVOLUTION IdM ConnId Federation Server Bundle 

 

The first three packages are available as WAR files and need to be deployed into Apache 
Tomcat. 

Before proceeding with deployment, some preliminary steps are required: 

1. Create a directory on the filesystem (/opt/syncope/bundles by default) and 

download the last two packages from the list above, which are provided as JAR files 

2. Create a directory on the filesystem (/opt/syncope/conf by default) for holding 

the various configuration files required by CHOReVOLUTON IdM, that need to be 
completed with (at least) the following information: 

a. URL for contacting the Enactment Engine 

b. URL for contacting the Federation Server 

3. Create a PostgreSQL database instance and grant all rights to a given user 

4. Configure an appropriate data source for Tomcat, for accessing the database 
instance just created; more information at https://tomcat.apache.org/tomcat-8.0-
doc/jndi-datasource-examples-howto.html 

At this point the WAR files can be deployed into the configured Apache Tomcat instance. 

Apache Tomcat can be tuned for every specific deployment’s requirements; a good starting 
point can be found at https://www.mulesoft.com/tcat/tomcat-performance . 

https://tomcat.apache.org/tomcat-8.0-doc/jndi-datasource-examples-howto.html
https://tomcat.apache.org/tomcat-8.0-doc/jndi-datasource-examples-howto.html
https://www.mulesoft.com/tcat/tomcat-performance
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4.7. Enactment Engine  
The Enactment Engine (EE) provides functionalities to automate the distributed deployment 
of service choreographies in cloud environments. This chapter is targeted mainly to EE 
administrators, providing instructions about how to install, configure, and run the Enactment 
Engine. 

4.7.1. Installation requirements 
Download the latest EE executables package from the CHOReVOLUTION website, unpack 
in a folder of your choice. 
Open the folder  
<enactment engine>/src/main/resources  

and create a ee.properties file by renaming/copying the ee.properties.template file. The new 
properties file must be created in the same folder of the template.  
Open the created properties file and edit it following the instructions provided in the file itself. 
The following listing is an example of the file parameters.  
 
DEFAULT CLOUDACCOUNT=MYAWSACCOUNT 

# Values in node selector.properties 

NODE SELECTOR=LIMITED ROUND ROBIN 

# Maximum number of VMs that can be created; set if using NODE 

SELECTOR=LIMITED ROUND ROBIN 

VM LIMIT=10 

# Creates a reservoir of extra VMs to make the deployment faster 

and more scalable. 

# The trade-off is the cost of some more VMs. 

# If the pool size reaches the threshold, the pool size is 

increased by one. 

# To not increase your pool size, set threshold as negative or 

greater than the initial pool size. 

RESERVOIR=true 

RESERVOIR INITIAL SIZE=5 

RESERVOIR THRESHOLD=-1 

 
The options to NODE SELECTOR are: 

 ALWAYS CREATE: a new VM is created to each deployed service instance. 

 ROUND ROBIN: NodeSelector makes a round robin using the available VMs, without 
creating any new VM; usually it makes sense to use it only when using the fixed cloud 
provider. 

 LIMITED ROUND ROBIN: initially the NodeSelector behaves like the ALWAYS CREATE, 
until a limit of created VMs is reached (VM LIMIT). After this limit, the selector behaves 
like the ROUND ROBIN. When using this selector, it is necessary to declare the integer 
VM LIMIT property in the conguration file. 

 
Do the same to the clouds.properties.template fille containing the connection and interfacing 
parameters for your selected cloud provider (OpenStack is the only supported provider for 
CHOReVOLUTION at this time). 
 
# options for <clustername>.CLOUD_PROVIDER: FIXED (for tests), AWS 

and OPEN_STACK 

 

MY_CLUSTER.CLOUD_PROVIDER=FIXED 

MY_CLUSTER.FIXED_VM_IPS= 
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MY_CLUSTER.FIXED_VM_HOSTNAMES= 

MY_CLUSTER.FIXED_VM_PRIVATE_SSH_KEYS= 

# user with passwordless login and sudo 

MY_CLUSTER.FIXED_VM_USERS= 

# Types of previously defined machines 

MY_CLUSTER.FIXED_VM_TYPES= 

 

################## Amazon access configuration 

MY_AWS_ACCOUNT.CLOUD_PROVIDER=AWS 

MY_AWS_ACCOUNT.AMAZON_ACCESS_KEY_ID= 

MY_AWS_ACCOUNT.AMAZON_SECRET_KEY= 

# AMAZON_KEY_PAIR must be registered on the AWS web console 

MY_AWS_ACCOUNT.AMAZON_KEY_PAIR=tfmend 

# the correspondent public key must be registered on the AWS web 

console, related with the AMAZON_KEY_PAIR above 

MY_AWS_ACCOUNT.AMAZON_PRIVATE_SSH_KEY=/home/thiago/vpn-

revoada/ssh/id_rsa 

# optional 

#MY_AWS_ACCOUNT.AMAZON_IMAGE_ID=us-east-1/ami-3337675a 

#MY_AWS_ACCOUNT.AMAZON_INSTANCE_TYPE=m1.medium 

 

################# Openstack access configuration 

MY_OPENSTACK_ACCOUNT.CLOUD_PROVIDER=OPEN_STACK 

MY_OPENSTACK_ACCOUNT.OPENSTACK_IP=http://172.16.239.1:5000/v2.0 

MY_OPENSTACK_ACCOUNT.OPENSTACK_TENANT=CHOReOS_Sandbox 

MY_OPENSTACK_ACCOUNT.OPENSTACK_USER= 

MY_OPENSTACK_ACCOUNT.OPENSTACK_PASSWORD= 

MY_OPENSTACK_ACCOUNT.OPENSTACK_KEY_PAIR= 

MY_OPENSTACK_ACCOUNT.OPENSTACK_PRIVATE_SSH_KEY=/home/thiago/vpn-

revoada/ssh/id_rsa 

MY_OPENSTACK_ACCOUNT.OPENSTACK_IMAGE_ID=RegionOne/1654b5b6-49b7-

4039-b7b7-0e42e85480f4 

# optional 

#MY_OPENSTACK_ACCOUNT.OPENSTACK_IMAGE_ID=RegionOne/1654b5b6-49b7-

4039-b7b7-0e42e85480f4 

#MY_OPENSTACK_ACCOUNT.OPENSTACK_FLAVOR_NAME=m1.smaller 

 
To run the compiled EE just run the following command in the EE build directory.  
mvn exec:java 

If the EE correctly starts, you will see the following message on the console: 
Enactment Engine has started 

[http://localhost:9102/enactmentengine/] 

Please refer to the following grids for a summary of minimum and recommended HW 
requirements. 
 

Table 11 - Memory usage 

Product Recommended alloc. memory 

Enactment Engine 1 GB minimum, 2 GB recommended 

The same requirements also apply for disk usage. It also depends on your projects but can 
be summarized as: 
 

http://localhost:9102/enactmentengine/
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Table 12 - Disk usage 

Product Required disk space for 
installation 

Required disk space 
for use 

Enactment Engine 500 MB 1 GB 

 
Please refer to the following grids for a summary of supported OS and Java Runtime 
environments. 
 

Table 13 - Java environments 

Support type Vendor Version 

Recommended Oracle Java/JDK 7 and above 

 

Table 14 – OS requirements 

Support type OS Version Processor 

Recommended Unix Linux Ubuntu 14.04 64-bit 

Supported Unix 

Debian-based distribution  64-bit 

CentOS >=6.0 64-bit 

Red Hat Enterprise Linux   

SUSE Linux Enterprise Server 12 64-bit 

Deprecated     

 

5. Platform components and API reference 

This section includes additional internal details about the single components of the 
CHOReVOLUTION platform, including  

 a short description of the functionalities provided within the CHOReVOLUTION 
architecture and, if available, as a standalone component 

 the specification of the exposed APIs 

 

5.1. Synthesis Processor  

5.1.1. General component description and functionalities 

The Synthesis Processor (as shown in figure below) is realized by a number of REST 
(REpresentational State Transfer) services that perform synthesis-time activities, and related 
model transformations, to automatically generate CDs, Adapters, Security Filters and 
Binding Components. It exposes a full-compliant JAX-RS 2.0 RESTful interface which 
enables third-party applications, written in any programming language, to consume synthesis 
processor services. 
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Figure 18 – Synthesis processor logical schema 

5.1.2. API reference 

This section lists the REST APIs of each component as tables with the following columns: 

- HTTP method; 

- URI; 

- Example of request body; 

- Example of responses and error codes. 

Here follows the legenda for the following symbols that appears in the tables: 

- xxxx:  omitted xml code; 

- -----: separator. 

Synthesis Processor 

The Synthesis Processor offers a REST operation startSynthesis that takes as input 

the BPMN choreography specification, the additional models, sythesizes the CDs, As, BCs, 
SFs, and generates the ChoreoSpec by using all the other REST services. 

 

HTTP 
Method 

URI Example of request body Example of responses 
and error codes 

POST /startSynthesis Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><syn

thesisProcessorModel/> 

200 OK 
 Response contains 

the following xml 

response 
xxxx 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 
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M2M Transformator 

The M2M Transformator offers a REST operation bpmn2clts that takes as input the BPMN 

specification of the choreography and performs the model-to-model transformation to derive 

the CLTS. In addition, the M2M Transformator offers the functionality clts2coords to 

distributes the coordination logic specified by the derived CLTS into the set of needed 
Coordination Models. 

 

HTTP 
Method 

URI Example of request body Example of responses and 
error codes 

POST /bpmn2clts Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?> 
<choreographyBPMNSpec

ification> 
<bpmnSpecification>xx

xx</bpmnSpecification

> 
<choreographyName>xxx

x</choreographyName> 
</choreographyBPMNSpe

cification> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><clts

Model><choreographyName

>xxx</choreographyName>

<cltsModel>xxx</cltsMod

el></cltsModel> 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

  
 

POST /clts2coords Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><cl

tsModel><choreography

Name>xxxx</choreograp

hyName><cltsModel>xxx

x</cltsModel></cltsMo

del> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><clts

2CoordsResponse><partic

ipants><coordModels/><n

ame>name</name></partic

ipants></clts2CoordsRes

ponse> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

Behaviour Simulator 

The Behaviour Simulator offers a REST operation simulation that takes as input two 

IPLS Models (for example, the first one can be the projected (abstract) CLTS of the 
participant and the second one can be the related IPLTS extracted from the service 
inventory) and returns a boolean value. It implements a notion of strong simulation suitably 
extended to treat IPLTSs. In addition, the Behaviour Simulator offers two functionalities 

projection(s)that take as input a CLTS Model and project the choreography onto the 
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participant(s), hence filtering out those transitions, and related states, that do not belong to 
the participant(s). 

 

HTTP 
Method 

URI Example of request body Example of responses and 
error codes 

POST /simulation Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><sim

ulationRequest> 

<firstIPLTSModel/> 

<secondIPLTSModel/></s

imulationRequest> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?> 

<simulationResponse> 

<simulation>xxxx</simu

lation> 

</simulationResponse> 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

  
 

POST /projection Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><pro

jectionModel><cltsMode

l><choreographyName>xx

xx</choreographyName><

cltsModel>xxx</cltsMod

el></cltsModel><partic

ipantName>xxxx</partic

ipantName></projection

Model> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><ipl

tsModel><ipltsModel>xx

xx</ipltsModel><partic

ipantName>xxxx</partic

ipantName></ipltsModel

> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

POST /projections Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body: 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><clt

sModel><choreographyNa

me>xxx</choreographyNa

me><cltsModel>xxx</clt

sModel></cltsModel> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><pro

jectionsResponse><proj

ections><ipltsModel>xx

xx</ipltsModel><partic

ipantName>xxxxx</parti

cipantName></projectio

ns></projectionsRespon

se> 
 ----- 
400 BAD REQUEST 
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404 NOT FOUND 
500 ERROR 
 

POST /projections Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body: 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><clt

sModel><choreographyNa

me>xxx</choreographyNa

me><cltsModel>xxx</clt

sModel></cltsModel> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><pro

jectionsResponse><proj

ections><ipltsModel>xx

xx</ipltsModel><partic

ipantName>xxxxx</parti

cipantName></projectio

ns></projectionsRespon

se> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 
 

POST /projections Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body: 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><clt

sModel><choreographyNa

me>xxx</choreographyNa

me><cltsModel>xxx</clt

sModel></cltsModel> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><pro

jectionsResponse><proj

ections><ipltsModel>xx

xx</ipltsModel><partic

ipantName>xxxxx</parti

cipantName></projectio

ns></projectionsRespon

se> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 
 

 

CD Generator 

The CD Generator has two REST operations generateCoordinationDelegate and 

generateCoordinationDelegates. The first one, generates the Coordination Delegate 

artifact (as Java web application) by taking as input the related CoordModel. The second 

one generates a set of Coordination Delegates related to the CoordModels as input. 

 

HTTP 
Method 

URI Example of request body Example of responses and 
error codes 

POST /generateCoor

dinationDeleg

ate 

Headers: 
Content-Type: 

application/xml 
Accept: 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 
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application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><coo

rdModel><coordModel>xx

xx</coordModel></coord

Model> 

encoding="UTF-8" 

standalone="yes"?><coo

rdinationDelegate/> 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

  
 

POST /generateCoor

dinationDeleg

ates 

Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><coo

rdinationDelegatesRequ

est><coordModels/></co

ordinationDelegatesReq

uest> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><coo

rdinationDelegatesResp

onse><coordinationDele

gates/></coordinationD

elegatesResponse> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

Adapter Generator 

The Adapter Generator has two REST operations generateAdapter and 

generateAdapters. The first one, generates the Adapter artifact (as Java web 

application) by taking as input the related AdapterModel. The second one generates a set 

of Adapters related to the set of AdapterModels. 

 

HTTP 
Method 

URI Example of request body Example of responses and 
error codes 

POST /generateAdap

ter 
Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><ada

pterModel/> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><ada

pter/> 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

  
 

POST /generateAdap

ters 
Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><ada

ptersRequest><adapterM

odels/></adaptersReque
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standalone="yes"?><ada

ptersRequest><adapterM

odels/></adaptersReque

st> 

st> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

Security Filter Generator 

The Security Filter Generator has two REST operations generateSecurityFilter and 

generateSecurityFilters. The first one, generates the Security Filter artifact (as Java 

web application) by taking as input the related SecurityFilterModel. The second one 

generates a set of Security Filters related to the set of SecurityModels. 

 

HTTP 
Method 

URI Example of request body Example of responses and 
error codes 

POST /generateSecu

rityFilter 
Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><sec

urityFilterModel/> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><sec

urityFilter/> 
----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

  
 

POST /generateSecu

rityFilters 
Headers: 
Content-Type: 

application/xml 
Accept: 

application/xml 
Body:  
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><sec

urityFiltersRequest><s

ecurityFilterModels/><

/securityFiltersReques

t> 

200 OK 
 Response contains the 

following xml response 
<?xml version="1.0" 

encoding="UTF-8" 

standalone="yes"?><sec

urityFiltersResponse><

securityFilters/></sec

urityFiltersResponse> 
 ----- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 

 

 

5.2. Federation Server and Security  

5.2.1. General component description and functionalities 
The Federation Server is in charge of solving, as much as possible, the different security 
interoperability issues. The Federation Server is composed by two main components: 

 The Security Token Service (STS) 

 The Policy Decision Point (PDP) 
The first one is in charge of providing security between services by issuing and validating 
security tokens to establish trust relationships between a Web service client and a Web 



 

CHOReVOLUTION  41 
Grant agreement no: 644178  

service provider. The second one is in charge of enforcing access control based on various 
attributes and XACML Policies. 
The Security Filter is the component deployed by the enactment engine to enforce the 
security of the Choreography deployed. This filter is implemented as a reverse proxy servlet 
using servlet filter. 

5.2.2. API reference 

STS user interface usage 
The STS API provides two endpoints: 

 The administration endpoint: management of the authentication of the user. This 
endpoint will be used by the IdM to push user information like credentials, user 
identity and possible authorisation policies not XACML compliant. 

 The user endpoint: user credential verification and mapping. This endpoint will be 
used by the different security filters deployed for the choreography to validate and 
map user credential. 

PDP user interface usage 
The Authorization PDP API provides two endpoints: 

 Policy Administration Point (PAP): management of authorization policies, used for 
access control management. This endpoint will be used by the IdM to push new 
policies; 

 Policy Decision Point (PDP): evaluation of authorization decision requests against 
authorization policies managed by the above PAP, used for access control 
enforcement. This endpoint will be used by the different security filters deployed for 
the choreography to check the authorization of the user. 

STS consumer API  
The STS provides Web Service operations based on the WS-Trust reference API. This API 
is used by the Security filter to authenticate the user and to map her credential for the 
service provider: 

 ISSUE: This first operation is used to create a valid token for the user. The generation 
of the token is realized only if the authentication of the user is valid at the Federation 
Server. 

o  Input: Some few parameters are required as input, like the TokenType (SAML, 
X509, etc.), the claims (data information about the user), LifeTime (duration of 
validity). Some authentication information is mandatory to authenticate the 
user. 

o Output: The result of this operation is a new token generated. 
 

 RENEW: This operation is the method used to regenerate a new authentication token 
with new expiration information. The result of this operation is a new generated token. 

o Input: The authentication credentials of the user are required as well as the 
expired token. 

o Output: The result of this operation is a new token generated. 
 

 VALIDATE: This operation is used to validate tokens previously generated by the 
STS. 

o Input: The required parameter is the token to validate. 
o Output: The result is true or false depending on the validity of the token. 
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 CANCEL: This last operation is used to invalidate a token previously generated by the 
STS. When a token is cancelled, it cannot be renewed. 

o Input: The authentication credentials of the user are required as well as the 
token to cancel. 

o Output: The result of this operation is just the tag RequestedTokenCandelled, if 
all is OK. 

Each API user different messages formats passed during the request or the response. The 
two main messages are the  
<wst:RequestSecurityToken>  

and  
<wst:RequestSecurityTokenResponse>  

elements.  
An example of each elements are: 
 

    <soap:Envelope xmlns:soap="http://www.w3.org/2003/05/soap-

envelope"> 

    <soap:Header> 

    <wsse:Security xmlns:wsse="http://docs.oasis-

open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-1.0.xsd" 

xmlns:wsu="http://docs.oasis-open.org/wss/2004/01/oasis-200401-

wss-wssecurity-utility-1.0.xsd" env:mustUnderstand="true"> 

    <wsse:UsernameToken wsu:Id="UsernameToken-1"> 

    <wsse:Username>user</wsse:Username> 

    <wsse:Password Type="http://docs.oasis-

open.org/wss/2004/01/oasis-200401-wss-username-token-profile-

1.0#PasswordText" xmlns:wsse="http://docs.oasis-

open.org/wss/2004/01/oasis-200401-wss-wssecurity-secext-

1.0.xsd">password</wsse:Password> 

    <wsse:Nonce EncodingType="http://docs.oasis-

open.org/wss/2004/01/oasis-200401-wss-soap-message-security-

1.0#Base64Binary">JpQqP2iLrH9DbvaX0GAO9g==</wsse:Nonce> 

    </wsse:UsernameToken> 

    </wsse:Security> 

    <Action xmlns="http://www.w3.org/2005/08/addressing" 

soap:mustUnderstand="true">http://docs.oasis-open.org/ws-sx/ws-

trust/200512/RST/Issue</Action> 

    <MessageID xmlns="http://www.w3.org/2005/08/addressing" 

soap:mustUnderstand="true">urn:uuid:9901f17a-14c4-4dc0-a639-

132b96d5fd0d</MessageID> 

    <To xmlns="http://www.w3.org/2005/08/addressing" 

soap:mustUnderstand="true">https://gazelle.ihe.net/picketlink-

sts</To> 

    <ReplyTo xmlns="http://www.w3.org/2005/08/addressing" 

soap:mustUnderstand="true"> 

    

<Address>http://www.w3.org/2005/08/addressing/anonymous</Address> 

    </ReplyTo> 

    </soap:Header> 

    <soap:Body> 

    <wst:RequestSecurityToken xmlns:wst="http://docs.oasis-

open.org/ws-sx/ws-trust/200512"> 

    <wst:RequestType>http://docs.oasis-open.org/ws-sx/ws-

trust/200512/Issue</wst:RequestType> 

    <wsp:AppliesTo xmlns:wsp="http://www.w3.org/ns/ws-policy"> 
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    <wsa:EndpointReference 

xmlns:wsa="http://www.w3.org/2005/08/addressing"> 

    <wsa:Address>http://testHost/HelloService</wsa:Address> 

    </wsa:EndpointReference> 

    </wsp:AppliesTo> 

    <wst:TokenType>http://docs.oasis-open.org/wss/oasis-wss-saml-

token-profile-1.1#SAMLV2.0</wst:TokenType> 

    </wst:RequestSecurityToken> 

    </soap:Body> 

    </soap:Envelope> 

 

A possible response could be: 
 

    <S:Envelope xmlns:wsu="http://.../oasis-200401-wss-wssecurity-

utility-1.0.xsd" 

    xmlns:S="http://www.w3.org/2003/05/soap-envelope"> 

    <S:Header> 

    <wsse:Security xmlns:wsse11="http://.../oasis-wss-wssecurity-

secext-1.1.xsd" 

    xmlns:wsse="http://.../oasis-200401-wss-wssecurity-secext-

1.0.xsd" 

    S:mustUnderstand="1"> 

    <wsu:Timestamp> 

    <wsu:Created>2015-11-08T11:03:20Z</wsu:Created> 

    <wsu:Expires>2015-11-08T11:08:20Z</wsu:Expires> 

    </wsu:Timestamp> 

    </wsse:Security> 

    </S:Header> 

    <S:Body> 

    <trust:RequestSecurityTokenResponseCollection 

    xmlns:wst="http://schemas.xmlsoap.org/ws/2005/02/trust" 

    xmlns:wsse="http://.../oasis-200401-wss-wssecurity-secext-

1.0.xsd" 

    xmlns:wsp="http://schemas.xmlsoap.org/ws/2004/09/policy" 

    xmlns:wsa="http://www.w3.org/2005/08/addressing" 

    xmlns:trust="http://docs.oasis-open.org/ws-sx/ws-

trust/200512"> 

    <trust:RequestSecurityTokenResponse> 

    <trust:TokenType> 

    http://docs.oasis-open.org/wss/oasis-wss-saml-token-profile-

1.1#SAMLV2.0</trust:TokenType> 

    <trust:RequestedSecurityToken> 

    <saml:Assertion 

xmlns:saml="urn:oasis:names:tc:SAML:2.0:assertion" 

    ID="uuid-76a197ba-c2e8-4704-97a2-147db7619f2c" 

    IssueInstant="2015-11-08T11:03:20Z" Version="2.0"> 

    ... 

    <saml:Subject> 

    <saml:NameID NameQualifier="STS">user</saml:NameID> 

    <saml:SubjectConfirmation 

    Method="urn:oasis:names:tc:SAML:2.0:cm:sender-vouches"/> 

    </saml:Subject> 

    ... 

    </saml:Assertion> 
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    </trust:RequestedSecurityToken> 

    <trust:RequestedAttachedReference> 

    <wsse:SecurityTokenReference> 

    <wsse:KeyIdentifier 

    ValueType="http://.../wss/oasis-wss-saml-token-profile-

1.1#SAMLID"> 

    uuid-76a197ba-c2e8-4704-97a2-147db7619f2c 

    </wsse:KeyIdentifier> 

    </wsse:SecurityTokenReference> 

    </trust:RequestedAttachedReference> 

    ... 

    <wsp:AppliesTo> 

    <wsa:EndpointReference> 

    <wsa:Address> http://testHost/HelloService</wsa:Address> 

    </wsa:EndpointReference> 

    </wsp:AppliesTo> 

    <trust:Lifetime> 

    <wsu:Created>2015-11-08T11:03:20.344Z</wsu:Created> 

    <wsu:Expires>2015-11-08T11:09:20.344Z</wsu:Expires> 

    </trust:Lifetime> 

    </trust:RequestSecurityTokenResponse> 

    </trust:RequestSecurityTokenResponseCollection> 

    </S:Body> 

    </S:Envelope> 

 

STS administration API 
These methods are exposed for usage by IdM, with purpose of creating, reading, updating 
and deleting end-users data. The Federation Server will use this information to map 
credentials and to evaluate Authorization policies.                                                                             
All methods manipulates a JSON string representing an end-user, according to the following 
format: 
{ 

“username”: “<USERNAME_VALUE>”, 

“credential”: “<CREDENTIAL_VALUE>”, 

“groups”: [ 

    “<GROUP1_NAME>”, 

    “<GROUP2_NAME>”, 

    … 

  ], 

  “ATTRIBUTE1_KEY: [ 

    “<ATTRIBUTE1_VALUE1>”, 

    “<ATTRIBUTE1_VALUE2>”, 

    … 

  ], 

  “ATTRIBUTE2_KEY: [ 

    “<ATTRIBUTE2_VALUE1>”, 

    “<ATTRIBUTE2_VALUE2>”, 

    … 

  ], 

  … 

} 
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5.2.2.1.1. List end-users of the given domain 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

GET /domains/{domain}/users - 
  

200 OK 
 Body: JSON array 
containing End-user 
JSON 
representations 
 
------- 
400 BAD 
REQUEST 
404 NOT FOUND 
500 ERROR 
  

  

5.2.2.1.2. Create an end-user under the given domain 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

POST /domains/{domain}/users/ 
  

End-user JSON 
representation 
  

201 CREATED 
Location: 
/domains/{domain}/ 
 users/{id} 
  
----- 
400 BAD REQUEST 
500 ERROR 
  

  

5.2.2.1.3. Retrieve an end-user from the given domain 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

GET /domains/{domain}/users/{id} - 
  

200 OK 
Body: 
End-user JSON 
representation 
 ------- 
400 BAD 
REQUEST 
404 NOT FOUND 
500 ERROR 

5.2.2.1.4. Update an end-user under the given domain 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

PUT /domains/{domain}/users/{id} End-user JSON 
representation 
  

200 OK 
  
------- 
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400 BAD 
REQUEST 
404 NOT FOUND 
500 ERROR 
  

  

5.2.2.1.5. Delete an end-user from the given domain 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

DELETE /domains/{domain}/users/{id} - 
  

204 NO 
CONTENT 
  
------- 
400 BAD 
REQUEST 
404 NOT FOUND 
500 ERROR 
  

  
  

Policy Administration API 
The PAP is used by policy administrators to manage the policy repository from which the 
PDP loads the enforced policies. The PAP supports multi-tenancy in the form of generic 
administration domains that are separated from each other. Each policy administrator 
(except the Superadmin) is in fact a domain administrator, insofar as she is allowed to 
manage the policy for one or more specific domains. Domains are typically used to support 
isolation of tenants (one domain per tenant). 
The PAP provides a RESTful API for creating/removing domain.  
HTTP requests to this API must be formatted as follows: 

HTTP 
Method 

URI Example of request body Example of responses 
and error codes 

POST /domains 
  

Headers: 

 Content-Type: application/xml 

 Accept: application/xml 
Body: <?xml version="1.0" 
encoding="UTF-8"?><taz:properties 
xmlns:taz="http://thalesgroup.com/authz
/model/3.0/resource"><name>MyDomai
n</name><description>This is my 
domain.</description></taz:properties> 

200 CREATED 
Location: /domains/{id} 
  
----- 
400 BAD REQUEST 
500 ERROR 
  

 
 
The PAP provides a RESTful API for creating/updating policies for a specific domain, i.e. the 
top-level, a.k.a. root XACML PolicySet of the domain. HTTP requests to this API must be 
formatted as follows: 

HTTP 
Method 

URI Example of request body Example of responses 
and error codes 

POST /domains/{
domainID}/
pap/policyS

Headers: 

 Content-Type: application/xml 

 Accept: application/xml 

200 CREATED 
  
----- 
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et 
  

Body: XACML PolicySet as defined in 
the XACML 3.0 schema 

400 BAD REQUEST 
500 ERROR 
  

 
It is not possible to delete a policy, as a minimal policy must always be in place. 

Policy Decision API 
The PDP API returns an authorization decision based on the currently enforced policy, 
access control attributes provided in the request, and possibly other attributes resolved by 
the PDP itself. The Authorization decision is typically Permit or Deny. The PDP is able to 
resolve extra attributes not provided directly in the request, such as the current date/time 
(environment attribute). The PDP provides an HTTP RESTful API for requesting 
authorization decisions. The HTTP request must be formatted as follows: 

HTTP Method URI Example of request body Example of 
responses and 
error codes 

POST /domains/{domainID}/pdp 
  

Headers: 

 Content-Type: 
application/xml 

 Accept: 
application/xml 

Body: XACML Request as 
defined in the XACML 3.0 
schema 

200 XACML 
Response as 
defined in the 
XACML 3.0 
schema 
  
----- 
400 BAD 
REQUEST 
500 ERROR 
  

 

Security Filter Administration  API 
The Security filter provides management API call directly by the IdM. This API is used to : 

 Enable/disable the security filter depending on the IDM order 

 push context information provided by the IDM (The context is used to adapt the 
securitry requirement depending of the context provided) and  

 retrieve runtime information about service to the IDM like availability, selected security 
context, monitoring, … 

5.2.2.1.6. Enable / disable 

HTTP Method URI Example of request 
body 

Example of 
responses and 
error codes 

PUT /management/{status} - 
  

200 OK 
 
------- 
400 BAD REQUEST 
500 ERROR 
  

Where {status} can be: 

 ENABLE 

 DISABLE 

5.2.2.1.7. Force security context 

HTTP Method URI Example of 
request body 

Example of 
responses and 
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error codes 

PUT /management/securityContext 
  

JSON 
representation of 
security context 
conditions 
  

200 OK 
  
----- 
400 BAD 
REQUEST 
500 ERROR 
  

5.2.2.1.8. Retrieve runtime information 

HTTP Method URI Example of request 
body 

Example of 
responses and 
error codes 

GET /management/info - 
  

200 OK 
Body: 
JSON representation 
of runtime 
information 
  
------- 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 
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5.3. Identity Manager and Service Inventory  

5.3.1. General component description and functionalities 

The Core (as shown in the figure below) is the central component, providing all services 
offered by Apache Syncope. It exposes a full-compliant JAX-RS 2.0 RESTful interface which 
enables third-party applications, written in any programming language, to consume IdM 
services. 

 

 

Figure 19 - Identity Manager and Service Inventory logical schema 
The IdM core component is composed by the following logical layers: 

 REST is the fully-compliant JAX-RS 2.0 RESTful interface 

 Logic implements the overall business logic that can be triggered via REST services, 
and controls some additional features (notifications, reports and audit over all). 

 Provisioning is delegated to manage the internal (via workflow) and external (via 
specific connectors) representation of users, groups and any objects. Being the 
crucial decision point for defining and enforcing the consistency and transformations 
between internal and external data, this component needs often to be tailored on 
requirements of specific deployment. For this reason, besides the all-Java default 
implementation that can be anyway extended, an Apache Camel-based 
implementation is also available as extension, which brings all the power of runtime 
changes and adaptation. 

 Service Inventory is a sort of logic grouping of all the features about services and 
service roles life-cycle management. It includes features crossing both REST and 
Logic layers. 

 Workflow is one of pluggable aspects: this lets every deployment choose the 
preferred engine among provided - including the one based on Activiti BPM, the 
reference open source BPMN 2.0 implementation - or define new, custom ones. 
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 Persistence manages all data (e.g. users, groups, attributes, resources) at high level 
using a standard JPA 2.0 approach, persisting to an underlying database, referred as 
the Internal Storage. Consistency is ensured via the comprehensive transaction 
management provided by the Spring Framework. Globally, all this permits to scale up 
to million entities and at the same time allows great portability with no code changes: 
MySQL, MariaDB, PostgreSQL, Oracle and MS SQL Server are fully supported 
deployment options. 

 The Provisioning layer relies on ConnId Framework. ConnId is designed to separate 
the implementation of an application from the dependencies of the system that the 
application is attempting to connect to. ConnId is the continuation of The Identity 
Connectors Framework (Sun ICF), a project that used to be part of market leader Sun 
IdM and has since been released by Sun Microsystems as an Open Source project. 
This makes the connectors layer particularly reliable because most connectors have 
already been implemented in the framework and widely tested.The new ConnId 
project, featuring contributors from several companies, provides all that is required 
nowadays for a modern Open Source project, including an Apache Maven driven 
build, artifacts and mailing lists. Additional connectors such as for SOAP, CSV, 
PowerShell and Active Directory - are also provided. 

 Security defines a fine-grained set of entitlements which can be granted to 
administrators, thus allowing to implement real delegated administration scenarios. 

5.3.2. API reference 

Besides the additional REST endpoints included in the CHOReVOLUTION IdM and detailed 
below, the CHOReVOLUTION IdM Core comes with the full set of predefined REST 
endpoints provided with Apache Syncope. 
The full specification can be found at http://syncope.apache.org/rest/2.0/index.html 

Search for services matching the given Service Identity Role 

HTTP 
Method 

URI Example of 
request 
body 

Example of 
responses and 
error codes 

GET /anyObjects/search? 
  realm=/ 
  &page=X 
  &size=Y 
&fiql=$type==service; 
$relationshipTypes==serviceIdentityRole; 
$relationship=Z 

 
none 

200 OK 
Response contains 
JSON array with 
details about the 
services matching 
the given query 
 
----- 
400 BAD REQUEST 
500 ERROR 
 

 

This method allows to query for services in relationship ‘serviceIdentityRole’ with given any 
object Z; the result is returned as paged, for page X containing Y items at most. 

 

Retrieve all details for a given service 

HTTP 
Method 

URI Example of 
request body 

Example of responses 
and error codes 

GET /anyObjects/{key} 
 

 
none 

200 OK 

Response contains 

JSON details about 

http://syncope.apache.org/rest/1.2/index.html
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the requested 

service {key} 

 

----- 

400 BAD REQUEST 

404 NOT FOUND 

500 ERROR 

 

 

Submit the concrete ChorSpec of a newly enacted choreography 

HTTP Method URI Example of request 
body 

Example of 
responses and 
error codes 

POST /chors/{id} ChorSpec XML 
representation 
 
 

201 CREATED 

400 BAD REQUEST 

500 ERROR 

 

 

 
This operation will be invoked after a newly created choreography is enacted. In the request 
body, together with the concrete ChorSpec XML file, will be present the assigned id of the 
choreography. 
 

Submit the updated concrete ChorSpec 

HTTP Method URI Example of request 
body 

Example of 
responses and 
error codes 

PUT /chors/{id} Updated ChorSpec 
XML representation 
 
 

200 OK 
400 BAD REQUEST 
404 NOT FOUND 
500 ERROR 
 
 

This operation will used to notify the IdM that a modification of a choreography’s concrete 
ChorSpec occurred. Such modifications may occur after performing an action on a whole 
running choreography or on a single service of it. 

 

5.4. Enactment Engine  

5.4.1. General component description and functionalities 
The Enactment Engine (EE) provides functionalities to automate the distributed deployment 
of service choreographies in cloud environments. This chapter is targeted mainly to EE 
administrators, providing instructions about how to install, configure, and run the Enactment 
Engine. 
We will use the following definitions in this chapter: 

 Infrastructure provider: the cloud IaaS layer, creates and destroys virtual machines 
(also called nodes) in a cloud computing environment. Currently, only Amazon EC2 
and OpenStack are supported as infrastructure providers, with OpenStack as the 
main reference cloud platform, but the Enactment Engine can be extended to support 
other virtualization technologies. 
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 Automation engine: The EE makes use of the Chef Infrastructure Automation engine 
to perform several of its configuration provisioning tasks. Chef-solo is installed by the 
Enactment Engine in each cloud node to manage \recipes" execution. Chef recipes 
are scripts written in a Ruby-like Domain Specific Language that implement the 
process of configuring operational system, installing required middleware, and finally 
deploying the services. 

 EE client is a script, written by choreography deployers, that specifies the 
choreography deployment and invokes the EE to trigger the deployment process.  

 Choreography Deployer is the human operator responsible for the deployment 
process. The EE deploys choreography services according to the specification sent 
by the client. 

 

Figure 20. Enactment Engine logical schema 
The above figure depicts the EE main sub-components and the protocols internally used to 
interact between one another. In synthesis, the EE: 

 Exposes a REST interface towards the EE Client to receive the XML file describing 
the choreography (ChorSpec) for choreography deployment 

 Interacts via REST API with the cloud provider (e.g. OpenStack) for the deployment of 
the various VM nodes needed for the choreography to run 

 Connects with the deployed nodes via SSH to setup the Chef Solo agent and, 
subsequently, to pass it the Chef recipes needed for further deployment of the 
choreography services 

The location of the service artifacts to be deployed must be specified in the ChorSpec XML. 
The EE performs a second round of configuration provisioning to configure service 
dependencies for pro-sumer services, by connecting via REST to the SetInvocationAddress 
API exposed by the services themselves and providing them the IP of the connected service. 

5.4.2. API reference 
The CHOReVOLUTION Enactment Engine exposes its features through a REST API,  
described in this section. The different commands are described separately for the various 
steps of the choreography deployment process 
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Create a choreography 

HTTP Method URI Example of 
request body 

Example of responses 
and error codes 

POST /chors 

 
ChorSpec XML 
representation 
 

201 CREATED 

Location: 

/chors/{id} 

 

----- 

400 BAD REQUEST 

500 ERROR 

 

Creates a specification of the choreography on the CHOReVOLUTION Enactment Engine. It 
does not enact the choreography. 

Retrieve choreography information 

HTTP Method URI Example of 
request body 

Example of responses 
and error codes 

GET /chors/{id} none 

 

200 OK 

Body: 

Choreography XML 

representation 

------- 

400 BAD REQUEST 

404 NOT FOUND 

500 ERROR 

 

If this operation is invoked after the creation and before the enactment of a choreography, 
the body response will be a Choreography representation without any deployed service. 

Enact a choreography 

HTTP Method URI Example of 
request body 

Example of responses 
and error codes 

POST /chors/{id}/en

actment 

none 

 

200 OK 

Body: 

Choreography XML 

representation 

------- 

400 BAD REQUEST 

404 NOT FOUND 

500 ERROR 

 

With this invocation, services will be finally deployed. The response arrives only after the 
deployment of all services, if no deployment fails. It is possible to parse the output to find out 
failed deployments, which will be the services without associated nodes.  
The enactment action is performed in sequence after the creation action 

Perform an action on a choreography 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

POST /chors/{id}/{a

ction}/ActionP

arameters 

{Action} must 

match one of 

the four 

following 

actions: 

200 OK 

400 BAD REQUEST 

404 NOT FOUND 

500 ERROR 
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- PAUSE 

- RESUME 

- SHUTDOWN 

- RELEASE 

 

ActionParamete

rs: 

(Plain HTTP 

request 

parameters 

list, not 

specified 

further, 

action 

specific) 

 

 

5.5. eVolution Service Bus  (VSB)  
The CHOReVOLUTION Service Bus (VSB) is a development and runtime environment 
which provides an interoperability solution, for both services and Things participating in 
choreographies. 

5.5.1. General component description and functionalities 
The main objective of VSB, is to seamlessly interconnect services and Things that employ 
heterogeneous interaction protocols, to the specific choreography protocol at the middleware 
layer. This interconnection is done by a component associated to the service/Thing and its 
protocol, called a Binding Component (BC), as it binds the service/Thing to the choreography 
protocol.  
In the context of the CHOReVOLUTION project, we introduce the Generic Middleware (GM) 
paradigm [D3.1] which identifies and supports the basic interaction styles found in most 
middleware protocols: one-way interaction, two-way asynchronous interaction, two-way 
synchronous interaction, and stream interaction. We also distinguish between the two roles 
involved in an interaction, such as: sender and receiver, client and server, consumer and 
producer. In VSB, we define the GM API which relies on two main actions: a post action for 
sending a piece of data and a get action for receiving a piece of data, by using the 
corresponding primitives post() and get().  
In order to support heterogeneous interaction protocols we utilize the Protocol Pool that 
implements the GM API primitives with several concrete protocols (e.g., REST). In order to 
interconnect different protocols we define the GM logic that contains a set of rules combining 
the GM primitives for each interaction. Then, each service/Thing describes its own 
middleware protocol and supported interactions through a generic interface description 
(GMDL), which is in JSON format, inspired by the Swagger2 specification. 
To enable the incorporation of any service/Thing during the design of the choreography, we 
expose a REST interface, named VSB manager. The VSB manager is responsible for the 
binding of each service/Thing to the choreography, which is performed by generating a 
Binding Component (BC). Each BC exposes an additional REST interface, named BC 
manager, which is responsible for the configuration and enactment of it. The described 
components can be found in the Figure below.  

                                            
 
 
 
2
 http://swagger.io/ 



 

CHOReVOLUTION  55 
Grant agreement no: 644178  

 
 

 

Figure 21. VSB logical schema 
 
Based on the above, VSB can be used by middleware and application developers with the 
following ways: 

1. A middleware developer introduces a new protocol. 

2. An application developer incorporates a new service/Thing to the choreography. 

New protocol 
To facilitate middleware developers introducing new protocols, we are willing to develop an 
eclipse plugin. Using this plugin, a developer will be able to create a new project containing 
notable amount of code. More specifically, we intend to provide the following: i) the 
signatures of the GM API primitives with sufficient documentation covering all the 
interactions. The developer should implement as much as possible of the interactions where 
the protocol supports; ii) the signatures for the deployment (startup, shutdown, etc) of each 
component role (client, server, etc); and iii) the automatic binding of the component to the 
parent Protocol Pool. 

New service/Thing 
To include a new service/Thing in the choreography, it is necessary to provide the GMDL 
representation of it, describing the services supported interactions. Similar data information 
could exist in a WADL representation of a REST service. We intend to facilitate this 
procedure by providing several tools, for instance a parser to extract data from WADL and 
provide them to our GMDL, or templates for indicating the required data. Therefore, a 
service/Thing is included to the choreography through the following steps: 

1. The VSB manager requires a GMDL representation, which may be created by the 
developer or another tool, and the choreography protocol. 

2. If the service/Thing protocol is not included in the Protocol Pool, the VSB manager 
cannot create the corresponding BC. In such case, the middleware developer must 
enrich the Protocol Pool with the service/Thing concrete protocol.  

3. In case the protocol is supported, the VSB manager requires the corresponding BC 
from the BC generator. The architecture of the new BC is generic, as it uses primitives 
from the GM API to bridge the two protocols. The bridging functionality is 
implemented by the GM logic. Finally, an artifact with the BC is sent back. 

4. Through this artifact, the BC can be deployed. Finally using the BC manager, the BC 
can be configured and started or stopped.  
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5.5.2. API reference 

The CHOReVOLUTION Service Bus exposes one REST interface, called VSB Manager, in 
order to generate a BC between two protocols. Then, for each BC it exposes another REST 
interface, named BC Manager, for configuration and startup or shutdown purposes. In this 
section we describe the features of these interfaces.  

VSB Manager API 

5.5.2.1.1. Generate a Binding Component (BC) 

HTTP 
Method 

URI Example of request 
body 

Example of responses 
and error codes 

POST /bc-generator 

  
 GMDL 

representation 

 Choreography 

protocol 

  

201 CREATED 

Location: /bc-

generator/{id} 

  

----- 

501 NOT IMPLEMENTED 

400 BAD REQUEST 

500 ERROR 

 

This invocation generates a BC responsible to bridge the interactions defined in the GMDL 
representation of the service/Thing and the choreography protocols. The new BC is 
generated as a artifact on the resource "bc-generator" with a specific id. After the BC 
generation, a 201 response is sent back. In case both protocols are not supported, a 501 
response is sent back. 

5.5.2.1.2. Retrieve a BC artifact 

   

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

GET /bc-generator/{id} - 

  

200 OK 

Body: 

BC artifact 

------- 

404 NOT FOUND 

500 ERROR 

 

One BC artifact is requested from the resource "bc-generator" with a specific id. This 
invocation presupposes the BC is already generated. In case is not, a 404 response is sent 
back. 

BC Manager  API 

5.5.2.1.3. Configure a BC 

HTTP Method URI Example of 
request body 

Example of 
responses and 
error codes 

POST /bc-manager/configure JSON BC 

representation 

  

200 OK 

  

------- 

400 BAD REQUEST 

500 ERROR 
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With this invocation we configure the already deployed BC, in order to enact its operation. To 
be configured, the information is sent by using a JSON representation along with the 
necessary parameters (e.g., IP addresses, etc).  

5.5.2.1.4. Start/Stop a BC 

HTTP 
Method 

URI Example of request 
body 

Example of 
responses and 
error codes 

POST /bc-manager/{action} {Action} must 

match one of 

the four 

following 

actions: 

-          

START 

-          

SHUTDOWN 

  

200 OK 

  

------- 

400 BAD REQUEST 

404 NOT FOUND 

500 ERROR 

  

It performs an action to the "bc-manager" in order to startup or shutdown the BC operation.  
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